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User Guide for WorkZone 365
(former WorkZone Office) 2022.0

Related product documentation

l Developer Guide for WorkZone 365

l WorkZone Client User Guide

l Installation Guide for WorkZone

WorkZone links

l WorkZone support

l WorkZone website

l WorkZone portal
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What's new

WorkZone Teams enhancements

l You can now change your WorkZone documents' title and state, directly from
WorkZone Teams. See Edit document title and Edit document state.

l You can now recycle your WorkZone documents directly fromWorkZone Teams. See
Recycle an existing document.

l You can now add files from your file system as documents to WorkZone cases dis-
played in WorkZone Teams. Upload a new document from the file system.

l You can select which columns to display and adjust their width and order for each
case opened in the customWorkZone tab. See Configure columns displayed for a
case.

2021.3

Work with WorkZone from Microsoft Teams

You can now add WorkZone cases as custom tabs to Microsoft Teams and collaborate on
them directly from your Teams channels or private chats. See WorkZone Teams.

2021.2

User experience improvements

l The Parties tab has been added to the WorkZone 365 pane. See Manage email
parties.

l Improved logic for the Document type that is automatically assigned to new emails
when they are saved in WorkZone. See Work with emails in WorkZone.

l Improved search logic. See Work with emails in WorkZone.

l Improved contact resolution, when an email has multiple WorkZone contacts
registered with the same email address. See Work with emails in WorkZone.

l The Case field for the new emails is left empty by default, so that you can select the
needed case yourself.
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2021.1

WorkZone Mail is now supported

l In Microsoft Outlook, users can save emails to WorkZone and edit email information
in the WorkZone 365 pane.

l Senders and recipients of the email are automatically added to it as parties with
Sender and Recipient roles. Users can also add other WorkZone contacts as parties.

l WorkZone 365 pane can be pinned in Outlook, so that it will not disappear when
users switch between emails.

l Users with the administrative rights can configure the WorkZone 365 pane in Outlook.

2021.0

WorkZone Office renamed to WorkZone 365

l We have changed the name of WorkZone Office to WorkZone 365. To be ready for
the future and Microsoft 365, we will handle all integrations to Microsoft under our
new name.

New functionality

l NewWord, Excel, and PowerPoint documents can be saved to WorkZone.

l Users can change document state and manage parties for Word, Excel, and Power-
Point.

l Users can merge case, document, and contact information into a Microsoft Word tem-
plate.

l Users with the administrative rights can configure the WorkZone 365 pane in
Microsoft Word, Excel, and PowerPoint. See Configure Documents tab of the
WorkZone 365 pane.

l From an opened Word, Excel, and PowerPoint document, users can open the doc-
ument and case on which it is saved in the WorkZone Client.
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l For users with no write access to particular Word, Excel, and PowerPoint documents,
the WorkZone 365 pane will be disabled, and a warning "User does not have update
rights for this record in register: record" will be displayed.

Design improvements

l WorkZone 365 Add-ins are represented with a new icon.

2020.3

You can work with WorkZone 365, Microsoft Outlook meetings on macOS.

2020.2

l The language of the WorkZone Add-ins for Microsoft Outlook, Word, Excel, and
PowerPoint now depends on the user settings in WorkZone.

2020.1

l WorkZone for Office for Microsoft Word, Excel, and PowerPoint has been released.
This is the experimental version with limited functionality where you can only edit
existing documents. See Word, Excel, and PowerPoint.

Important: This is not the version to be used in production. Please install and
use it only for testing purposes and sharing your feedback with us. We expect
the MVP production version in the 2021.0 release.

User experience improvements

l To easily assign yourself as a case handler or as another role, select @Me from the
very top of the WorkZone users list.

l To easily assign your organizational unit to a relevant field, select @MyUnit from the
very top of the unit list.

l To quickly set a date, you can specify a time period in relation to the current time. See
How to set a date.
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Videos tutorials

l The video tutorial on how to work with WorkZone meetings and agenda items has
been added. The video on Meeting reports has been complemented with audio nar-
ration and translated to Danish. See Video tutorials.

2020.0

New in WorkZone meetings

l Meeting organizers can cancel WorkZone meetings. See Cancel WorkZone meeting.

l Attendees can decline WorkZone meetings. See Decline WorkZone meeting.

l Only meeting organizer can now create the WorkZone meeting.

l If you save a meeting on a case and the meeting contains an email address that is
linked to multiple contacts, you must select one contact to be associated with the
email address for this particular case.

l When you create a new meeting, it now contains a link to WorkZone Client in the
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meeting body.

New in agenda items

l The search for documents via a case has been simplified. The filter now contains a
single field Case where you can start typing a case number, case title, or expand the
field to see the full list of cases.

l You can open a document that is added to an agenda item in a relevant program. To
do this, click the document's name.

l When you generate a meeting report, you can turn on the Download toggle to save
the report on the local machine. Otherwise, it will only be saved on the WorkZone
meeting. Use this feature to view the report and share it with non-WorkZone users.
See Meeting reports.

Video tutorials

l Visit our new page Video tutorials for a video instruction on how to work with
WorkZone meeting reports.
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2019.3

New functionality:

l You can add attendees to the meetings.

l You can attach documents from the WorkZone server to agenda items.

l You can generate meeting reports.

User guide usability:

You can work in WorkZone Outlook by using a desktop application or on the web. Please be
aware that user interface of the desktop and web applications have minor differences. To see
only relevant information in the documentation, please select your application:

By default, you see documentation for the desktop Outlook.

2019.2

This is the first version of the WorkZone 365 User Guide
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Work in Word, Excel, and Power-
Point

l The language settings and the Date field pattern in the WorkZone 365 pane depend
on the user settings in WorkZone.

l For users with no write access to particular Word, Excel, and PowerPoint documents,
the WorkZone 365 pane will be disabled, and the warning "User does not have update
rights for this record in register: record" will be displayed.

Create and edit Word, Excel, and PowerPoint documents

To edit new or existing Word, Excel, and PowerPoint documents, proceed with the following
steps:

1. Open a Word, Excel, or PowerPoint document.

2. Go to the Home tab and click WorkZone in the main ribbon. The WorkZone 365
pane then opens.
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3. If you want to work with a newWord, Excel, and PowerPoint document, you should
save it to WorkZone. Click Save on the WorkZone 365 pane to save the document
to WorkZone. After this, the fields in the pane will be disabled and the Action
required alert is shown. In the alert dialog, select Open document. A new window
opens where you can edit your document. You can close the window that contains
the original document.

4. Change document content and/or WorkZone information such as title, document
type, and other fields.
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5. Click Save on the WorkZone 365 pane to save WorkZone information.

6. Type Ctrl+S to save the changed content.

l You can skip this step for the Word and Excel documents — content is
saved once you click the Save button in step 5.

Document information

l Title – Enter title of the document.

l Document Type – The document type indicates whether the document is, for
example, incoming, outgoing, or internal.

l Classification – Classification orders and prioritizes data based on its sensitivity. By
default, the classification code is inherited from the selected case, but you can
change it in this field. Note that supplementary documents inherit classification codes
from their main documents.

Important:

l Classification on the unsaved document is updated every time you
change its main document or case.

l Classification on the saved documents is not automatically updated
when you change classification on the documents' case or main doc-
ument.

l State – Document state shows what you can do with the document: who can see and
edit it, and what can be edited. The document state is reflected in the document's life
cycle.
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o Personal draft – UP. Can be viewed, edited and deleted by the creator only.

Note: To allow other employees view, edit and delete your personal draft
document, you must change its state to Draft.

o Draft – UÅ. When you save a document as a draft, you and other people in
your department or organization can edit the document in its native program.

o Locked document – UL. The document itself cannot be edited by anyone, but
document information can be edited by any user. Once saved, you cannot
revert the document state to draft.

o Archived – ARK. The document itself cannot be edited by anyone, but doc-
ument information can be edited by anyone. Once saved, you cannot revert
the document state to draft.

l Case Handler – Responsible contact for the document. By default, this is the contact
who created the document. To assign another contact as case handler, remove the
contact's name and start typing the required contact's name.

l Document Group – Select the group to which the document belongs, for example,
Decision, Confirmation, Consultation.

l Main Document – If your document is a supplementary document, select a main doc-
ument.

Note: When your document is saved in the archive as a supplementary doc-
ument, the Main document drop-down list is locked. If you want a different main
document, you must select it in WorkZone Client.

l Letter Date – Click the calendar icon to change the letter date. The default value of this
field is today's date.

l Reply Deadline – Click the calendar icon to type the date by which the document
should be answered.
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Note: If you have specified a letter date and a reply date, you should also add a
sender and a recipient. See Manage document parties.

Manage document parties

Document parties are the contacts that relate to the document. The contact's role (for example,
Sender, Author) defines how the contact relates to the document.
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1. On the Parties tab of the WorkZone 365 pane, use the Add parties search field to
add parties to the document. The parties available in the search are specified for
this document in WorkZone Client. You can search by name or address.
When you make a search for parties, use a wild card operator * to replace one or
more characters. For example, type "Eliz*" to find "Elizabeth".

2. If necessary, specify roles for the parties. The default role is Recipient.

3. Click the "X" near the party to remove it.

4. Click Save.

Merge case, document, and contact information with a Word template

You can merge case, document, or contact information with a Microsoft Word template.

Each template includes content controls. A Content control represents an information field of a
case, document, or contact (party); for example, (Case, Case handler) Name 1,
(Document) Title, and so on. When you merge a template with a certain case or document, con-
tent controls extract the related values from the case or document. For example, (Case, Case
handler) Name 1 can obtain value Ann, (Document) Title can obtain value Application form,
and so on.

Note: Merge is not available for the archived or locked documents.

Merge to a document not saved to WorkZone

1. Open a relevant template with the inserted content controls.

2. Go to the Home tab and click WorkZone in the main ribbon. The WorkZone 365
pane opens. Fill in all mandatory fields on the Document tab to activate the Merge
button.

3. On the WorkZone 365 pane, select the icon>Merge.
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After this, the document will be saved to WorkZone Content Server and the merge
will start.

4. A merged document with the values inserted from the WorkZone Content Server
and WorkZone 365 pane fields opens as a newWord document.
You should open the WorkZone 365 pane again if you want to edit its fields for the
merged document.

Merge to an existing WorkZone document

1. Open a relevant WorkZone document with the inserted content controls.

2. Go to the Home tab and click WorkZone in the main ribbon. The WorkZone 365
pane opens. Fill in all mandatory fields on the Document tab to activate the Merge
button.

3. On the WorkZone 365 pane, select icon>Merge.

4. A merged document with the values inserted from the WorkZone Content Server
and WorkZone 365 pane fields opens as a newWord document.

Tip: Open the WorkZone 365 pane again, if you want to edit the fields for
the merged document.

The state of the original document from which merge has been launched will be
changed to Personal draft – UP. The new merged document will open in the state
that was specified in the original document before it was merged.

19



WorkZone 365 2022.0

Open document or case in WorkZone Client

WorkZone Client provides a broader list of actions on changing the case and document details.
For example, you can define access codes or move a document to a different case. To open
cases and documents in WorkZone Client:

1. Go to the Home tab of Word, Excel, or PowerPoint and click WorkZone in the
main ribbon. The document registration pane opens.

2. To open the document in WorkZone Client, select Go to...>Document in WZ Cli-
ent on the WorkZone 365 pane.
To open the case on which the document is saved, select Go to...>Case in WZ Cli-
ent.
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Work in Outlook Mail and Meeting
The language settings and the Date field pattern in the WorkZone 365 pane depend on the
user settings in WorkZone.

WorkZone Meeting

Note: WorkZone Meeting does not fully support recurring meetings yet.

You can create WorkZone meetings from new or existing appointments and meetings in your
Outlook calendar. You can add agenda items to your WorkZone meetings and attach doc-
uments fromWorkZone.

You can view and edit some information for an already created meeting either from Outlook or
fromWorkZone Client. For example, you can add, edit, or delete agenda items or documents
saved on them.

Important: Only the meeting organizer can create the WorkZone meeting.

Create a new WorkZone meeting

If you have created an Outlook meeting, you can create it as a WorkZone meeting. When you
create a WorkZone meeting, a new case is created. Note that you cannot save a meeting on
already existing case.

1. In Outlook, go to calendar.
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2. Open a new or an existing Outlook appointment or meeting for which you want to
create a WorkZone meeting.

3. Click the WorkZone button.

1. Edit the meeting details. See Manage attendees.

2. If needed, add one or more agenda items to the meeting. See Manage agenda
items.

3. Click Create Meeting if you want to create a WorkZone meeting for a new Outlook
meeting.

The body of a WorkZone meeting contains a link to this meeting in WorkZone Client.

l Save your changes to a new Outlook appointment before closing it.

l If you are using macOS, save your changes to a new Outlook appointment before clos-
ing it.

Open a meeting in WorkZone Client

You can open a detail page for a meeting in WorkZone Client and view all information on this
meeting. In WorkZone Client, you can also add, edit, or remove agenda items and the doc-
uments saved on the meeting.

Click View in WorkZone Client on the body of the WorkZone meeting. The detail page of the
meeting opens in WorkZone Client.

Tip: Read more about WorkZone meetings in the User guide for WorkZone Client.

Cancel a WorkZone meeting

If you are a WorkZone meeting organizer, you can cancel the meeting that you organized. In
WorkZone, the state of the meeting will be changed to Canceled.
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To cancel the WorkZone meeting, follow this procedure:

1. Open the meeting.

2. Open the WorkZone pane.

3. Click the arrow next to the Update Meeting button and click Cancel Meeting. The
WorkZone meeting is now canceled.

4. Optionally, cancel the Outlook meeting. Then meeting's attendees will see in their
calendars that the meeting was canceled.

On the bottom of the WorkZone for Office pane, you can now see the Create Meeting button.
Click the button to create a newWorkZone meeting based on the existing Outlook meeting (if
you haven't canceled it). A newWorkZone case is then created. The agenda of the new
WorkZone meeting is empty. The Outlook meeting's attendees and organizer are saved as
case parties.

Decline a WorkZone meeting

If you are a WorkZone meeting attendee and you don't plan to participate in it, you can decline
the meeting. Once you declined it, it doesn't affect the meeting itself, but you're removed from
it as an attendee, that is as a case party.

Note: A declined WorkZone meeting will still exist in your calendar as an Outlook meet-
ing. To remove it from your calendar, decline the Outlook meeting too.

To decline the WorkZone meeting, follow this procedure:

1. Open the meeting.

2. Open the WorkZone for Office pane.

3. Click the arrow next to the Update Meeting button and click Decline Meeting.

Manage attendees

Attendees are meeting participants including meeting organizer.
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Add attendees to the meeting

1. In the meeting, start typing a name of the needed contact or a group of contacts in
the People field.

2. Once you see the right contact or group, click it to add as an attendee.

3. Repeat steps 1-2 for all contacts which you want to invite to the meeting.

Add attendees to the meeting

1. In the meeting, click To....

2. Double-click contacts or groups which you want to invite to the meeting.

3. Click OK.
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Remove attendees from the meeting

To remove the attendee, click next to it.

To remove the attendee, select it and click Del on your keyboard.

Manage agenda

When you create a meeting, or when you open an existing WorkZone meeting, you can add
agenda items with additional information to it. You can attach documents from the WorkZone
server only.

You can manage agenda items on the WorkZone 365 pane. To open the pane, click > Cal-

endar. On the meeting page, click WorkZone for Office on the main ribbon:

You can manage agenda items on the WorkZone 365 pane. To open the pane, click the
WorkZone 365 button on the main ribbon.

Add an agenda item

1. In the top part of a meeting, click Add item.

2. Enter the title of your agenda item and, if needed, provide a description.

3. If needed, attach one or more documents to your agenda item. See Work with doc-
uments.

4. Click Save.

5. Repeat steps 1-4 until you have added all needed agenda items.
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Tip: To reorder agenda items, drag an agenda item to the needed position.

Edit an agenda item

You can edit agenda items existing on your WorkZone meeting at any time.

1. Open a meeting where you want to edit an agenda item.

2. Point to the agenda item you need, and click Edit.

3. Make your changes. See Work with documents.

4. Click Save.

Delete an agenda item

1. Open a meeting where you want to delete an agenda item.

2. Point to the agenda item that you want to delete.

3. Click Delete, and then click Yes in the confirmation message.

Work with documents

You can add or remove WorkZone documents from an agenda item.
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Add a document

Start typing the document's name in the Documents field. Select the needed documents.

l Click to search by case title or case number.

l You can use operators *, ^ in Documents search but not in Case search. See Search
operators.

l When documents are attached, you can reorder them by dragging.

View a document

When the document is saved on an agenda item, you can view it in the corresponding pro-
gram. To do this, click its icon that is located prior to the title.

Due to functional limitations of Internet Explorer, sometimes the documents cannot be
open in this browser. There are two workarounds:

l Ask your administrators to add WorkZone for Office add-in host to the trusted
sites. Then you will get the link to download the document.

l Switch to Edge or Chrome and proceed.

Remove a document

Click next to the document that you want to remove.

Meeting reports

Tip: See the video tutorial Working with WorkZone meeting reports.
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Create a meeting report

You can generate a report so you have all information about the meeting in a single PDF file.
The report contains general information about the meeting (time, participants, etc.), agenda
items, and attached documents.

Prerequisite: To generate a report, the WorkZone meeting must already exist.

1. Open a meeting for which you want to generate a report.

2. Click the Create Report button on the WorkZone 365 pane.

3. Enter title, document type, classification, and other information relating to the
report.

4. To download the report on the local machine, turn on the Download toggle.

5. Click Create Report. The report is generated and attached to the meeting. You
can see it in WorkZone Client on the relating meeting detail page on the Docu-
ments detail tab. If you have turned on the Download toggle, the PDF file is saved
both locally and on the case.

Tip: Due to functional limitations of Internet Explorer, the report cannot be saved in this
browser. There are two workarounds:

l Ask your administrators to add a WorkZone 365 add-in host to the trusted sites.
Then you will get the link to download the report.

l Switch to Edge or Chrome and proceed.

Share a meeting report

WorkZone users can always generate the meeting report themselves, or they can find the gen-
erated report on the relevant case.

To share a meeting report with non-WorkZone users, proceed with the following steps:
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1. Create a meeting report and save it locally.

2. Open the existing meeting or create a new email depending on what audience you
want to share the report with.

3. Go to the Insert tab.

4. Click Attach File > Browse This PC... and attach the report.

5. Click Send Update for the existing meeting or Send for the new email. Now all
recipients can see the report even if they are not WorkZone users.

1. Create a meeting report and save it locally.

2. Open the existing meeting or create a new email depending on what audience you
want to share the report with.

3. Click Attach and attach the report.

4. Click Send. Now all recipients can see the report even if they are not WorkZone
users.

Important: Only meeting organizers can attach meeting reports and other files to the
meetings they created.

Work with emails in WorkZone

In the WorkZone 365 pane in Microsoft Outlook, you can edit email information for your sent or
received emails saved to WorkZone.

Prerequisite: WorkZone 365 Outlook - Mail module is only supported with Microsoft
Exchange Server Online. It is not supported with Exchange Server 2019.
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Tip:

l Click Pin in the upper right corner of the WorkZone 365 pane, to pin this

pane. This will prevent it from closing when you switch between emails.
However, if you need to switch between many emails very quickly, we recom-
mend not to pin the WorkZone 365 pane, and instead open it for a particular
email with which you want to work in WorkZone (see Outlook Mail — Incorrect
data is shown for some time in the pinned WorkZone 365 pane when you are
quickly switching between emails).

l You can also work with saved WorkZone emails fromWorkZone Client and
WorkZone Explorer.

l All sent and received emails are saved to WorkZone. Send a new email to save it to
WorkZone.

l An email and its attachments are saved to WorkZone as a single.eml file.

l For emails saved to WorkZone, you can change information in all fields. Click Save
after changing the email information in the WorkZone 365 pane, to save your changes
to WorkZone.

l Before an email is saved to WorkZone for the first time, you can select its State as
Archived – ARK or Locked document – UL.

o Locked document – UL. The email state can be changed to Archived – ARK.
o Archived – ARK. The email state cannot be changed.

l The Document type field will be automatically set to I, Incoming, except for the fol-
lowing scenarios:

o If sender is the current user, the Document type will be set to O, Outgoing.
o If sender's email is directly in the To or Cc fields, the Document type will be

left empty.
o If the email is located in a shared mailbox, the Document type will be left

empty.
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Configure WorkZone 365 pane

See Configure Documents tab of the WorkZone 365 pane.

Manage email parties

Email parties are the contacts that relate to the email. The contact's role (for example, Sender
or Recipient) defines how the contact relates to the email.

When you open the WorkZone 365 pane, the contacts of an opened email will be automatically
added as parties on the Parties tab:

o The email sender will be saved as a party with the Sender role.
o The email recipients on the To and Cc lines of the email will be saved as parties with

the Recipient role.
o The recipients on the Bcc line of an email will not be added as email parties.

Note:

l You will be notified if an email contact is not found in WorkZone database.

l If there is more than one contact registered with the same email address in the
WorkZone database, you will be prompted to select which contact you want to
save as a party on that email.

Add WorkZone contacts as email parties

You can add or remove email parties or change their roles at any time.

1. On the Parties tab of the WorkZone 365 pane, use the Add parties search field to
add new parties to the email. The parties available in the search are specified for
this email in WorkZone Client. You can search parties by name or by email.
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Tip: When searching, word order does not matter, but you must enter full
words. You can also use a wild card operator * to replace one or more char-
acters in a word. For example, type "Eliz*" to find "Elizabeth".

2. If necessary, change roles for the parties. The default role is Party.

3. If necessary, click the "X" next to the party to remove it.

4. Click Save.
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Configure Documents tab of the
WorkZone 365 pane

Prerequisite: You must have the CONFIGADM access code to configure the Documents
tab of the WorkZone 365 pane.

To open the Edit configuration form, in the lower-right corner of the WorkZone 365 pane, click

the icon > Configure .

Edit the configuration of the Documents tab and then save your changes.
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Edit configuration

Change order of the fields

To change the order of the fields, drag a field up or down.
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Make fields visible or invisible

Note: Title, Document type, Classification, State, and Case fields cannot be made
invisible.

The fields can be visible (marked with the Visible icon ) or not visible (marked with the Not

visible icon ). Click the visibility icon to change the setting to the opposite.

Manage field properties

1. Select Field properties icon near the field.

2. Select or clear the Read-only or Required check boxes.

Note: Only one of these check boxes can be selected for the field. Clear a previously
selecting check box before selecting another.

Save or discard configuration changes

When saving changes in the configuration for the first time, select Create in the bottom of the
Edit configuration form.

Next time you make changes in to the configuration, you will see Save instead of Create. Click
Save to save the changes.

Select Cancel to discard the changes.

3. Reset the configuration to default

1. Open the Edit configuration form.

2. Select Reset in the bottom of the Edit configuration form.

3. Select Save.
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Note: The Reset button becomes available, if any changes have been made to the
default configuration.

36



User Guide

How to set a date
When you set or edit a date, you can use one of these options:

l Type the exact date.

l Select the date from the calendar.

l Specify a time period in relation to the current time, for example, + 2 weeks or - 4
hours.

To specify the time period, use the following syntax that is aligned with both Danish and Eng-
lish:

Value Meaning

+ Add a date in the future

- Add a date in the past

Å

Y

Year

M Month

U

W

Week

D Day

Example:

l +4u – Will set a date of 4 weeks from the current day.

l -1y – Will set a date of 1 year before the current date.

l You can only enter a simple value for each date field, for example, +7w. Do not use
compound values, for example, +1m3w.
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l Day is the default time period. If you just enter a number without a time value,
WorkZone 365 counts it as a day. Thus, +6 equals +6d.
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Use search

When you make a search, you enter search criteria in a text field or in a free text fields. Search
operators can be typed with small letters, capital letters, or a mix.

Search operators

Operator Name Used where? Description

* Wild card Free text fields
and text fields

Replaces one or more characters.

Example

If you type:

l day* – the search finds documents where
a word in a text field or in a free text field
starts with day. For example, daylight.

l *day* – the search finds documents
where a word in a text field or in a free
text field contains day. For example,
nowadays.

l *day – the search finds documents where
a word in a text field or in a free text field
ends with day. For example, birthday.

Note: Using prefixed wild cards is not recom-
mended in free text searches, for example
*day and *day*. This type of search can gen-
erate numerous search results and take
very long time to perform.

? Question
mark

Free text fields Replaces exactly one character.

Example: If you type Pe?ersen in the Free text
field of the Add/Remove Parties dialog box, the
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Operator Name Used where? Description

search finds all parties with the name Petersen or
Pedersen but not Pettersen.

^ Hat (cir-
cumflex)

Text fields Disregards casing.

Example: Text field Title

If you type ^*sun*, the search finds documents
where a word in the Title field contains sun, for
example, Sunday and sunlight.

|

OR

OR Free text
fields:

|and OR

Text fields:

|

Searches for items where one or more of the
entered words occur.

A free text search for documents will search in
fields and in the document itself.

Example: Find all documents where at least one
of the words currency or exchange occur by typing
currency OR exchange.

&

AND

AND Free text
fields:

& and AND

Text fields:

(except for
"Case title")

Searches for items where all entered words occur.

Example: Find all documents where the words cur-
rency and exchange occur by typing currency
AND exchange (the words may exist as document
properties or as indexed free text).

Tip: If you want to search for the character
&, not as an operator but, for example, as
part of a contact, insert a backslash in front
of the character, \&. That is, if you want to
find Liebestraum, Immergut & Co, type
Liebestraum, Immergut \& Co.

~

NOT NOT

Free text fields

Text fields:

Searches for items where words you type after the
operator do not occur.

Example: Find all documents where interest but
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Operator Name Used where? Description

NOT not bank occur by typing interest NOT bank.

Tip: Always search for an item containing
this but not that. That is, searching for only
NOT bank will not return any results.

Multiple words or sentences

You can type one or more words in the search field:

l If you type one word, search results will contain this word.

l If you type multiple words, search results will contain exactly these words. For
example, a sentence without operators: Does surface activity of the sun influence our
climate.

l If you do not know the exact wording, it is recommended that you search for single
words combined with search operators.

Example: If you type a combination of words that does not exist in the database (for
example, Does surface activit* of the sun influence our climate) there will be no search
results. The chances of finding the needed information are greater, if you only type the
key words (for example, surface activity* AND sun*).
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WorkZone Teams

Prerequisite:

l The WorkZone Teams app is currently only supported on WorkZone Cloud Edi-
tion.

l Your organization must use Azure AD in order to use Microsoft Teams with
WorkZone.

l You must have the WorkZone Teams application installed and configured. See
Install WorkZone Teams.

WorkZone Teams app allows you to work with WorkZone directly from Microsoft Teams. Using
WorkZone Teams, you can add WorkZone cases as custom tabs to Microsoft Teams and col-
laborate on them directly from your Teams channels or private chats.

l You can add up to 16 WorkZone cases as custom tabs in Teams. Each tab will display
the selected WorkZone case and all of its documents, including their most important
details, such as document ID, title, type, and state.

Add WorkZone tab to the Teams chat or channel 42

Configure columns displayed for a case 43

Open a case document 44

Edit document details 44

Recycle an existing document 45

Add a new case document 46

Add WorkZone tab to the Teams chat or channel

Note: Only team owners and members can add new tabs to a channel or a chat.
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1. In Teams, open a channel or a private chat.

2. On the navigation ribbon of this channel or chat, click Add a tab +.

3. In the Add a tab dialog, select WorkZone Teams from the list of available custom
tabs.

4. In the WorkZone Teams dialog, provide your WorkZone server address, select
the WorkZone case to add as a custom tab, and click Save.

Tip: You can select a WorkZone case from the drop-list or search for it (the
search covers only your most recently used cases) by typing relevant
search criteria.

The selected WorkZone case will appear on this Teams channel or chat as a cus-
tom tab. You can rename it as needed (this name change will apply only to the
selected custom tab in Teams, it will not affect the case title in WorkZone).

Tip: Click the case title at the top of the WorkZone tab to open this case
in WorkZone Client.

Configure columns displayed for a case

You can select which columns to display and adjust their width and order for each case
opened in the customWorkZone tab. You can display different columns for each WorkZone
custom tab. Your custom column settings are stored locally in the browser, so they will dis-
appear if you use a different browser or clear the browsing data.

1. In Teams, open the relevant WorkZone custom tab.

2. In the top right corner of the case title, click . The Column settings dialog with

the list of all available columns is then displayed.

3. Add, remove, resize, or reorder the columns as needed.

l Select the check box next to the column title, and then click the relevant
arrow to move this column from Available columns to Current columns,

43



WorkZone 365 2022.0

or vice versa.

Note: The Title column is always visible and cannot be removed.

l Reorder the currently displayed columns by dragging and dropping them
to the needed location in the Current columns pane.

l Resize the currently displayed columns by specifying their new width (in
pixels) in the Width field next to the column title in the Current columns
pane.

4. Click Save to save your changes (or Cancel to discard your changes, or Reset - to
restore the default column configuration).

Open a case document

You can open the case documents displayed in the customWorkZone tabs directly from
Teams. You can open these documents in the corresponding Office app (for Word, Excel, and
PowerPoint documents) or in WorkZone Client.

1. In Teams, open the relevant WorkZone custom tab.

2. To the right from a document you want to open, click ... (or right-click in the area
close to ...).

3. Here you have two options:

l Click Open, to open the document in the corresponding Office app (for
Word, Excel, and PowerPoint documents).

l click Open in WorkZone, to open the document in WorkZone Client.

Edit document details

You can edit the title or state for case documents displayed in the customWorkZone tabs in
Teams.
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Edit document title

1. In Teams, open the relevant WorkZone custom tab.

2. Right-click the document title that you want to edit, and click Change.

-Or-
Hover the mouse on the existing document title, and click ... next to it. Then click
Change.

3. In the following dialog, enter the new title, then click Save.

Edit document state

1. In Teams, open the relevant WorkZone custom tab.

2. Right-click the document state that you want to edit, and click Change.

-Or-
Hover the mouse on the existing document state, and click ... next to it. Then click
Change.

3. In the following dialog, select the new state, then click Save.

Recycle an existing document

Prerequisite:

l To delete an archived document that has a record number, you must have the
SOFTDELETE access code. Note that any user can delete an archived doc-
ument that is saved on the desktop case or belongs to the SJ-TEMP case
group.

l Any user can delete a document with the Personal draft, Draft or Locked doc-
ument state.

You can recycle (that is, soft delete) an existing case document that is displayed in the custom
WorkZone tabs in Teams. The recycled document and all of its supplementary documents (if
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any) will be moved to the recycle bin. It will disappear from the regular lists, but will not be
removed from the database, so you can restore it or hard delete it later, if needed. See Delete a
document into recycle bin in the WorkZone Client User Guide for more information about the
recycle functionality.

1. In Teams, open the needed WorkZone custom tab.

2. Next to a document you want to recycle, click ... (or right-click in the area close to
...).

3. Select Recycle.

4. For documents, where it is mandatory to provide a reason for recycling, select the
Recycle reason from the droplist and provide the Recycle comment (this step
may be optional or mandatory, depending on the retention policy).

5. Click Yes in the confirmation dialog. The selected document and all of its sup-
plementary documents (if any) will be moved to the recycle bin.

Add a new case document

You can add new documents to a WorkZone case, which is already displayed as a custom tab
in Teams. You can either create a newWord, Excel, or PowerPoint document and then save it
on the case displayed in Teams, or to upload one or more of the existing documents from your
file system.

Add a newWord, Excel, or PowerPoint document

1. In Teams, open the needed WorkZone custom tab.

2. Click New.

3. From the drop-list, select the needed document type (Word, Excel or
PowerPoint). A new document of the selected type is then opened.

4. Edit your document.
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5. Click Save.

Tip: By default, your new document will be saved on the case from the
selected WorkZone custom tab, but you can choose to save it on another
case, if needed.

Upload a new document from the file system

1. In Teams, open the needed WorkZone custom tab.

2. Click Upload.

3. In the displayed dialog, select the document (or multiple documents) that you want
to upload, and click Open.

-Or-
Drag and drop the needed files from the file system to the WorkZone case tab in
Teams.

Tip:

l You can drag and drop the whole folder to upload all the doc-
uments it contains.

l All documents uploaded from the file system will get the DOK type
and inherit the classification from the case. You can change them
in WorkZone Client, if needed.
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Troubleshooting and tips

Cannot save a new Microsoft Excel document to WorkZone

If you create a new Excel document, enter some data into a cell, and then fill out WorkZone
metadata and try to save this document to WorkZone, you will receive an error message say-
ing that your changes cannot be saved.

This is caused by the active cell-editing mode. Exit the cell-editing mode by pressing Enter, or
Tab, or selecting another cell, and then try again.

OAuth2 authentication mode — Cannot open the documents from an agenda item in Microsoft
Outlook

If your organization uses OAuth2 for user authentication, you must log in to WorkZone
Explorer to be able to open the non-Microsoft Office documents from an agenda item in
Outlook.

Outlook Mail — Incorrect data is shown for some time in the pinned WorkZone 365 pane when
you are quickly switching between emails

Please be aware that after you have been quickly switching between emails in the Outlook
while the WorkZone 365 pane was pinned, and then you stop on one of the emails, you may
see the data for another email in the WorkZone 365 pane for a while. If you need to switch
between many emails very quickly, we recommend not to pin the WorkZone 365 pane, and
open it for a particular email on which you want to work in WorkZone.

Outlook Mail — Cannot open saved emails in WorkZone Client

If you don’t have the installed WorkZone for Office Add-in, currently you cannot open the
emails saved to WorkZone via the WorkZone 365 Add-in in WorkZone Client. In this case
please use Microsoft Outlook or WorkZone Explorer to view the email saved to WorkZone.

Outlook Mail — WorkZone 365 Add-in button is disabled when the email is opened as an .eml
file in WorkZone Client or WorkZone Explorer
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It is a known issue. Please use the WorkZone 365 pane in Microsoft Outlook to edit the
WorkZone email information.

macOS — Cannot create or update WorkZone meeting in Outlook with multiple accounts

It is a known issue. You cannot create or update WorkZone meeting in Outlook because
WorkZone only supports one mail account on macOS. The meeting is opened with the mes-
sage "Meeting is declined" or "You either don’t have rights to view the WorkZone meeting, or it
doesn’t exist yet. Note that only meeting organizer has rights to create the WorkZone meet-
ing." when the user adds multiple calendars to the Outlook.

macOS — The Create button is disabled for recurring meetings when trying to create a
WorkZone meeting

It is a known issue. The Create button is disabled in Outlook because you cannot create a sep-
arate WorkZone meeting in the recurring meetings on macOS.

macOS — Cannot open the WorkZone 365 panel for Microsoft Word documents that are
archived or locked

It is a known issue. The WorkZone 365 icon is disabled in Microsoft Word for the documents in
the archived or locked state. The document registration tab is also disabled, and you cannot
edit the panel fields.

You have not made any changes to the document but when closing it you are asked if you
want to save your changes

It is a known issue. It is safe to select any option. This issue may happen after opening a
WorkZone 365 pane in a Word, Excel, or PowerPoint document.

Chrome — Cannot download a WorkZone meeting report in Outlook

It is a known issue. Currently you cannot download reports from Outlook using Chrome.
Please use another browser.

When using Outlook in a browser, you cannot update a WorkZone meeting via the WorkZone
365 pane
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It is a known issue. Sometimes when you close the meeting window in the Outlook after click-
ing Update meeting in the WorkZone 365 pane, you get a message prompting you to confirm
that you want to discard the meeting changes. Please close this message and click Send in
the Outlook meeting window. Your changes to the meeting will be saved.
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Terms and conditions

Intellectual property rights

This document is the property of KMD. The data contained herein, in whole or in part, may not
be duplicated, used or disclosed outside the recipient for any purpose other than to conduct
business and technical evaluation provided that this is approved by KMD according to the
agreement between KMD and the recipient. This restriction does not limit the recipient’s right
to use information contained in the data if it is obtained from another source without restriction
set out in the agreement between KMD and the recipient or by law.

Disclaimer

This document is intended for informational purposes only. Any information herein is believed
to be reliable. However, KMD assumes no responsibility for the accuracy of the information.
KMD reserves the right to change the document and the products described without notice.
KMD and the authors disclaim any and all liabilities.

Copyright © KMD A/S 2021. All rights reserved.
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